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INTRODUCTION 
The Pavement Marking Tools section introduces several applications that help the user in the creation of 
a Pavement Marking set of plans.  

Drawing the Pavement Markings in accordance with FDOT CADD Standards. The Traffic Plans SiteMenu 
provides tools with the active settings (Level and Symbology) used to create the markings. There are 
additional tools available to help in the efficient placement of directional arrows and message cells: the 
Pavement Marking Toolbox, GEOPAK’s Pavement Marking program and the GEOPAK Draw Cell group by 
Feature tool. 

Refer to chapter 23 in the Plans Preparation Manual, Volume II, for more detail on developing the 
Signing and Marking set of plans. Refer to the Design Standards indexes for design criteria. 

The Labeling of the plan sheet items has been made easier with the use of GEOPAK’s Plan Labeler, which 
allows you to create styles for the placement of repetitive labels. 

To assure that you are adhering to the Traffic Plans CADD Standards, the Traffic Plans SiteMenu provides 
an easy way to check and fix symbology to match the CADD standards. 

After the proposed Pavement Markings have been drawn, you are ready to clip the sheets. To aid in this 
task, you have two options available, the Traffic Plans SiteMenu Clipping program, commonly known as 
the FDOT clipping, and the GEOPAK’s Sheet Clipping program. 

Finally, you must compute the pay items used and populate the Tabulation of Quantities Sheet. 
GEOPAK’s Design and Computation Manager can count and report every “each” and “linear” item. 
Design and Computation Manager generates a report that can be polished in Microsoft Excel, which can 
then be imported into the MicroStation Tabulation of Quantities design file. 
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EXPLORING DESIGN AND COMPUTATION MANAGER 
The Design and Computation Manager or D&C Manager uses a proprietary database that is provided by 
FDOT. When the FDOT2004 software is installed the Design and Computation Manager database (DDB) 
is placed either on your server or on your local hard drive. It is recommended that you copy the DDB file 
from the FDOT2004 folder into your project SYMB folder and rename it to the eleven digit FIN number, 
example: the fdot2007.ddb would be renamed to 50735535201.ddb. This allows you to modify the 
database for specific parameters, and protect it from being overwritten by any future maintenance 
updates. The FDOT .ddb file is in the \FDOT2004\geopak\databases\ folder and is named 
fdot2007.ddb.  

When D&C Manager is opened during a design session it should not be closed, just minimize the dialog. 
This tool loads slowly because of the number of items in the database. 

It is highly recommended that every user that works on projects becomes very familiar with D&C 
Manger. D&C Manager should be the standard tool used by everyone whether they are drawing simple 
lines or designing major interchanges. Many other applications and processes rely on the features that 
D&C places on elements, if these features are not found then drawing cross sections, for example, 
would be nearly impossible. 

 

This database has been set up specifically by FDOT to create elements with the correct level symbology 
according to FDOT CADD Standards. The .ddb file is set up with discipline folders called categories. 
Inside of each category are items.  

 Categories - The basic component of the hierarchical tree is the Category, which is 
represented by a folder icon. The fdot2007.ddb database categories are divided by discipline. 
The figure above shows the Categories with a description relative to their discipline.  Inside 
these Categories you have either subcategories or items. Items are represented by one of three 
icons as described below.  
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 Items - The other database component is the item. An item could be a drafting item, a 
compute item or a default item. Items contain specific functions related to defined element 
symbology or quantity calculations. Items are represented by one of three icons: 

 Default Icon ‐These items are used to set drafting standards for MicroStation 
commands or to draw COGO elements without annotation. In many cases this is a 
3PC routine.  

 Drafting Standards Icon ‐ These items are used to set drafting standards for 
MicroStation commands or to draw COGO elements with annotation. 

  Calculator Icon ‐ These items are used to set drafting standards for 
MicroStation commands or to draw COGO elements. The graphics can be tagged 
with a pay item attribute for additional stratification of features when running 
computations. Computation parameters are defined for these items. 

DESIGN AND COMPUTATION MANAGER MENU BUTTONS 
Design and Computation Manager has a toolbar to quickly access different modes. The function of each 
button is summarized below. The tools used to create pavement marking plans will be covered in more 
detail later in this chapter. 

 

 ‐ Switch To Toolbox Mode. D&C Manager is set up to work in two different modes, as a dialog box 
or a toolbox. This button activates the toolbox mode. This toolbox can be resized and docked. To change 
the display back to the whole dialog box, click the Switch to Dialog Mode button. The Place Influence 
check box is at the left end of the toolbox.  

 ‐ Identify Item. The Identify Item button is used to set the D&C Manager item to match a selected 
MicroStation element previously drawn by the D&C Manager or elements drawn with Graphical COGO 
and the SMD file. If the item you ID does not match an item in the active database, a message appears in 
the status bar saying: No matching database item. This is a very useful tool for new users learning the 
hierarchy of the database. 

 ‐ Display. The Display button filters the display of MicroStation elements in the design file so only 
the selected features are displayed, highlighted or hidden. This button expands Design and Computation 
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Manager to show a collection bin. This collection bin is for controlling the display of multiple items at 
one time. To add items to the collection bin, double‐click the item. This tool also opens a second tool 
box with four buttons as seen in the figure below. 

 

From left to right the buttons are: Normal Display, Highlight Selection, Hide Selection and Display Only 
Selection. We will cover all of these in the exercises. 

 ‐ Design. The Design button is used to plot COGO and MicroStation elements into MicroStation 
with the defined symbology by use of Draw Plan and Profile dialog or in conjunction with MicroStation 
commands when Place Influence is toggled on. 

 

 ‐ Set. The Set button is used to set the symbology of previously drawn MicroStation graphic 
elements in accordance with the parameters of a selected item in the database. This is the tool you use 
if an element needs to be fixed to meet CADD standards. 

  

 ‐ Compute. The Compute button is used for tabulating quantities of items that have been placed as 
a Pay Item by use of the Design or Set mode or have been drawn in MicroStation and they match the 
search criteria of the ddb file. This tool also expands D&C Manager to show the collection bin; this 
allows you to process multiple pay items at one time. A second toolbox containing the computation 
results is also opened. Computing is covered later in this course. 
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 ‐ Shapes. The Shapes button uses plan view MicroStation graphics that defines an enclosed area to 
create a filled shape for computing area quantities. This tool will not be used in the creation of 
Pavement Marking Plans. However, this tool could be used to calculate Island Nose paint. 

 

 ‐ Pavement Marking. This mode provides additional options for placing pavement striping and 
markings. This tool adds four additional tools to D&C Manager as shown in the figure below.  

 

The four tools from left to right are: 

 Striping 

 Separation 

 Chevron Diverge 

 Chevron Merge 

 ‐ Preference. This expands the toolbar to include four additional buttons to configure D&C 
Manager. These tools are also accessible from the Edit menu. 

DESIGN SETTINGS 
There are some settings that need to be addressed before using D&C Manager to draw or compute 
items. These are the Design Settings loaded from the Settings > Design menu in D&C Manager. 

 

Maximum GAP Tolerance – If the distance between two specified elements in a MicroStation file is 
smaller than the Max Gap Tolerance, the software assumes the two elements intersect and act 
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accordingly. If the distance is larger than the Max Gap Tolerance, GEOPAK assumes the two elements do 
not connect. 

Deduction tolerance – The Deduction Tolerance is utilized in the Compute mode. For example, if the 
pay item is specified for a curb line, and for each manhole (drawn in as a cell), there is a deduction of six 
feet. The origin of the cell does not have to be on the curb line, but must be within the deduction 
tolerance in order for the cell to be recognized and the deduction to be made. 

Custom Line Style Creation – The Custom Line Style Scale Factor utilized during the Draw Plan & Profile 
dialog. Note this scale is only for custom line styles. Text and other labeling are controlled by the Label 
Scale on the Draw Plan & Profile dialog. 

Cell Creation – Plot Scale is utilized as a ratio with the Creation Scale within the setup of D&C Manager. 
If the Cell Creation Scale is 10 and the designer wants the cell twice as large as a cell placed with D&C 
Manager, utilize 20 as the Drawing Scale. 

If a drawing scale is entered all subsequent cells that are placed from the D&C Manager are scaled 
accordingly if the item is set to use creation scale. When the user places a cell with place influence on, 
GEOPAK utilizes the drawing scale setting to compute an X & Y scale for use in the MicroStation place 
cell dialog. Why do this? Otherwise, the user has to key‐ the X & Y scale in the place cell dialog whenever 
you change the item to be placed in D&C Manager. This also allows you to use a metric ddb with English 
cells by using a different creation scale. 

Influence Graphic Cell Level Symbology – When active, GEOPAK utilizes the symbology within the D&C 
Manager, ignoring the element symbology defined in the cell. 

DESIGN MODE 
Design Mode is the default mode when the D&C Manager is opened. Design Mode is used for the 
following functions:  

 Set Drafting Standards by use of the Place Influence command for the placement of 
MicroStation elements using MicroStation commands. 

 Plot COGO elements into the design file according to the drafting standards set by the item’s 
defined parameters. 

 Place Adhoc Attributes on an element. 

Whether an item is placed in the file by generic MicroStation commands or plotted from the COGO 
database, the items can be placed as pay items for future tabulation. The following sections will detail 
the procedure to set drafting standards for MicroStation commands and for the plotting of COGO 
elements. 
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By selecting Place Influence, you can use MicroStation commands to place elements utilizing the 
element attributes established for the currently selected item in the GEOPAK D&C Manager database. 
With some items, a GEOPAK attribute is placed with the element for calculating quantities.  

 

When Place influence is selected the MicroStation level symbology is set. Any MicroStation command to 
draw a line, copy a line or place a cell is set to this symbology. 

 

When the user is finished placing the elements for a selected item it is important to remember to turn 
off Place Influence. 

It cannot be stressed enough how important it is that all users working on projects become familiar with 
D&C Manager and use this tool for everything they do. D&C Manager should be the first tool opened 
when MicroStation is started and the last tool closed when the work day is done. 

ADHOC ATTRIBUTES 
An Adhoc Attribute is additional information about a particular element. Look at it as just another 
property for the MicroStation element. Example, a line has this fundamental data  associated to it: 

 Level 

 Color 

 Weight 

 Style 

By placing an Adhoc on the line you are giving that line additional information. That information could 
be a chain name, cross slope, profile name, thickness, etc. It is almost limitless as to what can be 
associated to an element with Adhocs. These Adhocs can be used by other applications down stream to 
generate quantities, draw cross sections or many other tasks. 

Some Adhocs are placed in the background and the user has no interaction with them for, example 
when a pavement message is placed with D&C Manager there is an AdHoc placed on the pavement 
message for computing quantities.  

The figure below shows the Adhocs that are associated to an item from D&C Manager. These Adhocs are 
part of the item and are set by default. The user would never know these were set.  
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Other Adhocs are interactive meaning the user must fill in the parameters, an example of this would be 
when placing the back of sidewalk. There are several pieces of additional information that the user can 
add to the sidewalk line. This information is then used to draw the sidewalk in the cross sections. 

 

AdHoc Attributes are comprised of three types of information that must be defined:  

1. Name  
2. Type 
3. Value  

The Name is an identifying term used when GEOPAK is searching for a specific Adhoc Attribute.  

The Type identifies the nature of the information, and can be set to various options: Numeric, String, 
Unit, Quantity, and Remarks.  

The Value is the actual information to be used by GEOPAK, and is determined by the Type. For example, 
if the Type is set to Numeric then the Value must be a number.  

DRAWING PAVEMENT MARKINGS 
Many of the Traffic Plan items are simple cells or line styles that can be drawn and quantified using the 
D&C Manager. The Pavement Striping component of the D&C Manager facilitates the production of 
pavement striping plans as well as automates the quantities process. To draw pavement markings with 
the GEOPAK’s Pavement Marking program, select the pay item then click on the Pavement Marking 
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button from the D&C Manager dialog box. After selecting the Pavement Marking button, D&C Manager 
displays additional Pavement Marking options.  

Hint As a best practice you should start the pavement marking design by placing one of the 
solid edge lines and build from that. This gives you a solid starting point to create the 
entire remaining pavement marking lines parallel to. 

 

As mentioned earlier in this chapter, there are four additional tools in D&C Manager to aid in the design 
and layout of pavement marking.  

DRAW STRIPING 
The Striping tool is the heart of this section in this training manual and will be the single most important 
tool used in the production of pavement marking plans. This is the tool used to draw all solid or skip 
pavement markings. The striping tool can reference a GEOPAK chain or an existing MicroStation linear 
element for length and offsets. The MicroStation elements can be in the active file or in a reference file. 
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The Draw Striping tool is broken into two parts, Pattern and Reference Element, with several 
preferences for the user to set in each of the two parts. The following pages detail the Draw Striping 
tool. 

PATTERN – The options are Single Stripe or Double stripes. 

Single Stripe A or Single Stripe B options allow two different configurations to be stored in a resource 
file so the user can change the type of stripe being placed very easily. It is basically a way to set 
favorites, example; the user could set Single Stripe A to 6” solid white and set Single Stripe B to 6” solid 
yellow. To draw a 6” solid white line set the pattern to Single Stripe A or to draw a 6” solid yellow line 
set the pattern to Single Stripe B.  In the case of Double Stripe, there are four possible configurations. 
Double Stripe A, B, C and D. The figure below shows the Double Stripe A Pattern, the example here is 
set up to draw a 6” solid yellow line on the Inside and a 6” 10/30 Skip line on the Outside with a 0.33’ or 
4” Distance Between Stripes. 

 
 

Below the  displayed item selection is the Skip/Solid option. This defines whether to start on a stripe or 
a skip and the length parameters for both. 
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If Single Stripe A is selected there are two options for drawing the line, Solid or Skip as shown in the 
figure above. If the Solid option is selected the Stripe Length and Skip Length are not utilized. If Skip is 
selected then the Stripe Length and Skip Length must be defined. 

Note When drawing skip lines it is easier to get the spacing correct by using the end point of 
the solid line that approaches the stop bar, starting on skip and placing the strip in 
reverse of the driving direction. The figure below shows this scenario. 

 

If Double Stripe A is selected there are four options for drawing the lines, Solid/Solid, Skip/Skip, 
Solid/Skip and Skip/Solid as shown in the figure below. These four options work in conjunction with the 
Inside and Outside pay item options. If either of the Pay Item Specifications has one of the key words, 
"solid" or "skip", as part of the D&C Item the Skip/Solid option will be set to the appropriate option. 
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Distance Between Stripes – Simply put, it is the space between two striping lines. This distance is 
expressed in terms of master units. There will be times when you will need to use a larger distance 
between lines than what the design standards call for. Example, if the signing and marking plans are at 
100 scale a 4” separation between two 6” lines would not be enough, the two lines would look like one 
thick line. 

Tolerance – If the length of a segment of pavement marking is less than the Tolerance, the line will not 
be placed. It will only be utilized at the ending point, to determine where the final piece of marking is 
placed. 

REFERENCE ELEMENT – The striping tool uses this as a reference for creating parallel lines and arcs. 
The options are, DGN or Chain. 

DGN – This can be any MicroStation element like the edge of pavement line or another striping line. 

When DGN is selected there are three options to choose when picking a MicroStation element: 

Single Element – When selected, use the Identify DGN Element button to pick the element. The 
stationing begins at 0.00 and the end is based on the length of the element selected. 

Complex Chain – Select the option, which invokes the MicroStation Create Automatic Complex chain 
tool to define the elements. Stationing begins at 0.00 and is based on the length of the selected 
element. This option does not work with elements in a reference file. 

Selection Set – This option works with elements in the active file or in a reference file. Create the 
selection set, and then set the toggle to Selection Set.  Click Accept Selection Set which computes the 
stationing for the selection set. MicroStation’s PowerSelector works very well for creating the selection 
set. 
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Chain – This is a GEOPAK chain stored in the GPK. Select the chain from the list or graphically with 
Identify Chain. Stationing fields are automatically populated. The values may be changed manually or 
graphically using the Beg and End buttons. 

Begin – Identifies the beginning of the striping. If using DGN element, this field will start at a value of 
0.00 or the value of the length of the line selected depending on how the element was created. The user 
can enter a value in the field to start the striping at a point other than the beginning of the line. If 
Station is used the begin station of the chain will the value. 

 

The figure below shows the reference line used which is 300’ long and also the new line created 33’ to 
the right of the beginning point. The reference line is just that, a reference, it does not have to control 
the length of the new striping line created. 

 

End – Identifies the end of the striping. If using DGN element, this field will start at a value equal to the 
length of the line or 0.00 depending on how the element was created. The user can enter a value in the 
field to end the striping at a point other than the end of the line. If Station is used the end station of the 
chain will the value.  
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The figure below shows the Chain option. Notice the Begin and End values are populated with the 
beginning and ending station values of the selected chain.  

 

Offset – This is the offset from the selected element, either the Chain or DGN element, to the new 
striping line. It is not necessary to use plus or minus values, as the user graphically indicates the side by 
moving the cursor to the left or right. 

Draw Stripes – This attaches the new striping to the cursor at the defined offset. The user can move the 
striping to the desired side of the DGN or Chain. Issuing a data point places the new striping in the 
design file. The new striping elements are placed in a graphic group for easy deletion. 

LAB EXERCISE: PLACING SOLID WHITE STRIPING 
In this exercise D&C Manager will be used to draw the solid pavement markings. The process will start 
by placing the outside edge lines using the Baseline of Construction as the reference element then the 
inside edge lines. Thermoplastic items will be used in this exercise. 

1. Open Dsgnsp01.dgn. This is the main design file for all signing and pavement marking 
elements. 

2. From the Road toolbox, open D&C Manger. Next open the project ddb file. 
3. From D&C manager select File > Open.  
4. Navigate to the symb folder. This is where you should copy and rename the FDOT2007.ddb.  
5. Select 50735535201.ddb and click OK. It takes several seconds to load, be patient. 
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6. Zoom to near STA. 525+00. This is basically where the edge lines will start. 
7. From D&C Manager click the Pavement Marking button. This activates four additional 

pavement marking tools. 
8. From D&C Manager navigate to the Pavement Markings > Thermoplastic > NM 

Striping, Thermo STD category. 
Hint From the Edit menu in D&C Manager there is a search tool to aid in finding a 

category or item within D&C Manager. To launch the search tool select Edit > 
Find. 

9. Select the Item 0711 11111 6” Solid Traffic Stripe (White). 
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10. From D&C Manager click on the Striping button. This opens the Draw Striping tool. 
11. Set the Pattern to Single Stripe A. Because the item was selected before starting this tool, 

the Single field is populated with the correct item. 

Note It is not necessary to close the Draw Striping tool to select a different item, go back to 
D&C Manager and select a new item then click the Single button to make it active or 
double click on the new item in D&C Manager. 

12. The type of line should be set to Solid. This is automatically set to solid because the item In 
D&C Manager was created with the key word Solid in the description. 

13. Set the Reference Element to Chain.  
14. From the drop down list select BLCONST. Selecting the chain will populate the Begin and 

End station values. 

 
15. For the Begin station click on the VCR button Begin Station to the right of the station field. 
16. Snap to the end of the edge of pavement line as shown in the figure below. This will populate 

the station with the value calculated from the chain. 

 
17. For the End station key in 592+69.  
18. Set the Offset to 44.00. It is not necessary to use a plus or minus with this tool. 
19. Click the Draw Stripes button. 
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20. Move your cursor to the right side of the Baseline and issue a data point. 
21. Right mouse click to stop the command. Do not close the Draw Striping dialog. 

LAB EXERCISE: PLACING SOLID YELLOW STRIPING (PART 1) 
In this part of the exercise you will draw the solid yellow edge line using the previously drawn white 
edge line as the reference element. 

1. Continuing in Dsgnsp01.dgn select the D&C Manger item to 0711 11211 6” Solid Traffic 
Stripe (Yellow). 

2. Leave the Pattern on Single Stripe A. 
3. On the Draw Striping dialog box click the Single button. This will change the item to the 6” 

solid Yellow item. 
4. For the Reference Element change the option to DGN.  
5. Set the type of element to Single Element. The options are Single Element, Complex Chain 

or Selection Set. 
6. Click the Identify DGN Element button.  
7. Pick the previously drawn 6” White Edge Line and issue a data point to accept it. 

 

The Begin field will be populated with 0.00 and the End will be the length of the element selected, this 
may need to be adjusted based on turn lanes and median openings. In this example there is a left turn 
lane that needs to be accounted for. 
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8. Zoom to near station 556+85. There is a left turn lane that we need to use for the end point, 
the figure below shows the location. 

 
9. Click on the End Distance button and Snap to the beginning of the turn lane as seen in the 

figure above. This will adjust the End Distance. 
10. Set the Offset to 24. This is the roadway width based on the typical section. 
11. Click the Draw Stripes button. 
12. Move your cursor to the left side of the previously selected edge line and issue a data point. 
13. Right mouse click to stop the command. 
14. Open the Reference palette and turn off Dsgnrd01. This will better show the lines just drawn. 

LAB EXERCISE: PLACING SOLID YELLOW STRIPING (PART 2) 
In this exercise the user will draw a 50’ taper using a 6” solid yellow line. This taper occurs at a median 
opening where there is a left turn lane. Later in this chapter you will place turn arrows in this left turn 
lane. 

1. Continuing in Dsgnsp01.dgn zoom to near Sta. 557+00. This is approximately where the turn 
lane starts. 

2. Turn the Dsgnrd01 reference file on. 
3. Make sure item 0711 11211 6” Solid Traffic Stripe (Yellow) is still selected. 

Next you will draw the yellow edge line starting 50’ from the beginning of the turn 
lane up to the PC of the median nose. You will use the white edge line as the 
reference element and adjust the begin and end lengths using the Begin and End 
distance buttons on the Draw Striping tool along with AccuDraw. The alternative 
would be that you would have to draw construction lines that you would later have 
to delete. 

4. On the Draw Striping tool click the Identify DGN Element button.  
5. Pick the previously drawn 6” White Edge Line and issue a data point to accept it. 
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The Begin distance will set to 0.0 and the End will be set to the length of the element selected. 

 
Next we will use AccuDraw and the Draw Striping tool to set the Begin distance 50’ to the right 
of the beginning of the turn lane. 
6. Activate AccuDraw. 
7. Click the Begin Distance button and snap to the end point of the line at the beginning of the 

turn lane. 

 
8. Push the letter O on the keyboard. This will move the AccuDraw compass to the location you 

just snapped to as shown in the figure above. 
9. Move the cursor to the right and push the Enter key. This locks the AccuDraw origin. 

 
10. Key in 50. This will set the X value to 50 in the AccuDraw dialog. 

As soon as you start entering a value the X origin will lock in as seen in the figure 
below. 

 
11. Issue a Data Point on the screen. This will move the AccuDraw compass over 50’ and 

change the Begin Distance by 50’ in the Draw Striping tool. 
12. Zoom to the end of the turn lane. 
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13. Click the End Distance button and snap to the PC of the median nose. 

 
14. Set the Offset to 36.0. This is the distance from the white edge line to the new inside yellow 

edge line. 

 
15. Click Draw Stripes.  
16. Move your cursor to the left side of the previously selected edge line and issue a data point. 
17. Reset to cancel the command. 

LAB EXERCISE: PLACING SOLID YELLOW STRIPING (PART 3) 
In this exercise you will draw the 6” yellow edge line representing the 50’ taper from the begin turn lane 
to the end of the line placed in the previous exercise. 

1. Continuing in Dsgnsp01.dgn turn off the reference file Dsgnrd01. You need to be able to see 
the endpoints of the yellow edge lines. 

2. Zoom to the beginning of the turn lane. 
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3. In D&C Manger click the Design button. 

 
4. Make sure item 0711 11211 6” Solid Traffic Stripe (Yellow) is still selected. It should be the 

current item as it was just used in the previous exercise. 
5. Check on Place Influence and AdHoc Attributes. 

 
6. Using MicroStation’s Place Line, draw a line from end point to end point to finish the taper. 

 
7. Reset to cancel the Place Line command. 
8. Turn off Place Influence. 
9. Turn on the reference file Dsgnrd01. 

LAB EXERCISE: PLACING SOLID WHITE TURN LANE STRIPE 
In this exercise you will draw the 6” solid white line in the left turn lane. The user will use the yellow 
edge line placed in the previous exercise as the reference element. Refer to index 301 for turn lane 
design criteria and index 17346 for special markings in turn lanes.  

1. Continuing in Dsgnsp01.dgn zoom so you can see the entire turn lane. 

 
2. In D&C Manager select Item 0711 11111 6” Solid Traffic Stripe (White). 
3. If you closed the draw Striping tool, open it again. 
4. Set the Pattern to Single Stripe B. 
5. Click the Single button. This will set the item from D&C Manager. 
6. Set the Reference Element to DGN and Single Element. 
7. Click the Identify DGN Element button. 
8. Identify the 6” yellow edge line drawn earlier. 
9. Click the Begin Distance button. Next you will use AccuDraw to set the Begin distance. 
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10. Snap to the end point of the line at the beginning of the turn lane. This is where the 50’ taper 
begins. 

 
11. Push the letter O on the keyboard. This will move the AccuDraw compass to the location you 

just snapped to as shown in the figure above. 
12. Move the cursor to the right and push the Enter key. This locks the AccuDraw origin. 
13. Key in 145. This will set the X value to 145 in the AccuDraw dialog. 
14. Issue a Data Point on the screen. This will move the AccuDraw compass over 145’. 

Note 145’ is distance L1 from the table on index 17346 based on a 60 (mph) design speed. 
This gives you a 310’ lane line.  The length 310’ is derived from L2 which is 260’ plus the 
Queue length. The Queue length is based on the number of vehicles making the turning 
movement, this exercise uses a Queue length of 50’. 

 
11. End distance, leave as is.  
12. Set the Offset to 12.0. This is the lane width. 
13. Click Draw Stripes. 
14. Move your cursor to the right side of the previously selected edge line and issue a data point. 
15. Reset to cancel the command. 
16. Take a moment to review the pavement markings. 
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The figure below shows the finished product, 145’ Clearance Distance and 310’ lane line. 

 

LAB EXERCISE: PLACING 6/10 WHITE SKIP STRIPE 
In this exercise you will complete the turn lane striping by placing a 6” white 6/10 skip line from the 
beginning of the turn lane to the 6” solid lane line. You will use the 6” white edge line as the reference 
element. 

1. Continuing in Dsgnsp01.dgn zoom to the beginning of the turn lane. 
2. In D&C Manager select Item 0711 11141 6” 6/10 Skip Traffic Stripe (White). This is 

located in the category Pavement Markings > Thermoplastic > LF Striping, Thermo STD 
> Skip Traffic Stripe (White). 

3. In the Draw Striping dialog set the Pattern to Single Stripe B. 
4. Click the Single button. This sets the pay item and sets the line to Skip. 
5. Set to Start on Stripe.  

Note When starting a skip line from a solid lane line and using a dgn element the user would 
set this to start on skip. 

6. Set the Stripe length to 6.0 and the Skip length to 10.0. 

 
7. Set the Reference Element to DGN and Single Element. 
8. Click the Identify DGN Element button. 
9. Identify the outside 6” white edge line drawn earlier. 
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10. Click the Begin Distance button and snap to beginning of the turn lane as shown in the figure 
below. 

 
11. Click the End Distance button and snap to the beginning of the turn lane as shown in the 

figure above. 
12. Set the Offset to 24.0. 

 
13. Click Draw Stripes. 
14. Move your cursor to the left side of the previously selected edge line and issue a data point. 

Note The user can adjust the begin and end points by using the vcr buttons to achieve the 
desired first stripe line. 

15. Reset to cancel the command. 
The figure below shows the finished skip stripes. Later in this chapter you will place left turn arrows in 
this turn lane. 
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LAB EXERCISE: PLACING 10/30 SKIP STRIPING 
In this exercise the user will add the 10/30 Skip Striping between the two edge lines previously placed. 

1. Continuing in Dsgnsp01.dgn in D&C Manger navigate to the GM Striping category and 
select item 0711 11131 6” 10/30 Skip Traffic Stripe (White).   

Note GROSS MILE ITEMS: The gross mile quantity shall be used to pay for all 3/9 or 10/30 
skip traffic stripes, as indicated in the plans. Measurement will be taken as the distance 
from the beginning of the first painted stripe to the end of the last painted stripe, and shall 
include the unpainted intervals, refer to the Basis of Estimates manual for more 
information. 

2. On the Draw Striping dialog box set the Pattern to Single Stripe B. 
3. On the Draw Striping dialog box click the Single button. This will change the item to the 6” 

10/30 Skip Traffic Stripe. 
Notice that the option for the type of line to draw switched to Skip; this is because 
the key word Skip is in the description of the item name in D&C Manager. 

4. Set to Start on Stripe. 
5. Set the Stripe length to 10.0. 
6. Set the Skip length to 30.0. 

Next you will need to set the Reference Element and Begin and End stations. 

7. Set the Reference Element to DGN. 
8. Set to Single Element. 
9. Click on the Identify DGN Element button. 
10. Pick the previously drawn 6” White Edge Line and issue a data point to accept it. 

The Begin and End distances are set based on the length of the DGN element 
selected. These values can be adjusted with key‐ins or by clicking on the Begin 
Distance or End Distance buttons to the right of the distance fields. 

11. Leave the Begin and End distances as they are. 
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12. Set the Offset to 12.0.  

 
13. Click the Draw Stripes button. 
14. Move your cursor in between the edge lines and issue a data point. 
15. Right mouse click to stop the command. 
16. Take a moment to review the striping lines, turn the reference files off to better see 

the line work. 

LAB EXERCISE: PLACING SOLID WHITE AND 10/30 SKIP STRIPING AT THE SAME TIME 
In this exercise you will use the Double Stripe A option on the Draw Striping tool to place a Solid White 
edge line and the White 10/30 skip line at the same time. This exercise will work on the left side of the 
Baseline. 

1. Continuing in Dsgnsp01.dgn zoom to near Sta 523+80. You will be working on the left side 
of the Baseline. 

2. Set the Pattern to Double Stripe A. This is in the Draw Striping tool. 
3. In D&C Manger navigate to the GM Striping category and select item 0711 11131 6” 10/30 

Skip Traffic Stripe (White). 
4. On the Draw Striping tool click the Inside button. This will set the Pay Item for the inside 

line. 
5. In D&C Manager navigate to the NM Striping category and select the Item 0711 11111 6” 

Solid Traffic Stripe (White). 
6. Set the Distance Between Stripes to 12.00. 
7. On the Draw Striping tool click the Outside button. This will set the Pay Item for the outside 

line. 
8. Set the option to Skip/Solid. Skip goes with the inside and Solid goes with the outside. 
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9. Set to Start on Stripe. This is a project specific setting not a default. 

 
10. Set the Reference Element to Chain. 
11. Click the Begin Station button. 
12. Snap to the end of the edge of pavement line as shown in the figure below. This will populate 

the station with the value calculated from the chain. 

 
13. For the End Station key in 592+39.55. 
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14. Set the Offset to 38.00. 

  

The Offset in this example is 44’ – 6’ = 38’ where 44’ is the distance from the BLCONST to the outside 
edge line and 6’ is half of the 12’ distance between stripes. 

14. Click the Draw Stripes button. 
15. Move your cursor in between the edge lines on the left side of the Baseline and issue a data 

point. 
16. Right mouse click to stop the command. 

LAB EXERCISE: PLACING SOLID YELLOW STRIPING (PART 4) 
In this exercise you will finish the left side of the Baseline with a single 6” solid yellow line. 

1. Continuing in Dsgnsp01.dgn zoom to near Sta 523+80.  
2. On the Draw Striping tool set the Pattern to Single Stripe A. The pay item data should be 

set already. This was set for the first yellow stripe, 0711 11211 6” Solid Traffic Stripe 
(Yellow). 

3. Set the Reference Element to Chain. 
4. Select the chain BLCONST. 
5. Snap to the same end of the edge of pavement line as in the last exercise. Sta 522+79.55. 
6. For the End Station key in 561+40.00. This is at a median opening. 
7. Set the Offset to 20.00. 
8. Click the Draw Stripes button. 
9. Move your cursor to the left side of the Baseline and issue a data point. 
10. Right mouse click to stop the command. 
11. Take a moment to review the striping lines just draws. Turn the reference files off to better 

see the lines. 
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DRAW CELL GROUP BY FEATURE 
The Draw Cell Group by Feature tool can be used for placing Pavement Messages and Arrows, RPM’s or 
any other cell you would like to group together. In this chapter the user will place RPM’s and Turn 
Arrows. It is not required to use this tool when placing cells however this tool will make the task of 
drawing Arrows and RPM’s much easier. 

Note  When using the Draw Cell Group by Feature and/or Draw Cell by Feature tools, always 
ensure to load the correct Geopak Database (*.ddb) as the tool will 'reset' the Database 
to the *.ddb specified in the resource file every time the tool is closed and reopened. 
 This Geopak Database (*.ddb) may not be the database intended for use with your 
active project. 

 

 

The dialog consists of two tabs: 

 Feature Group – defines the D&C Manager item to use which in turn selects the cell to be 
placed and the Offset from the selected element to place the item. 

 

Based on the items that are checked you can place up to three different cells with this tool. The 
Magnifying glass next to each item allows the user to browse to D&C Manager and select the 
appropriate item which will attach the cell to be drawn. The Offset is the distance off of the selected 
DGN Element or Chain when drawing the cell.  

 Location – defines whether you use a DGN element or Chain, Begin and End stations and 
Spacing. 
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Element – This is either a GEOPAK Chain or DGN element. This functions just like the Draw Striping tool. 
The Begin and End fields will be populated with the appropriate data based on the element selected. 
They can be modified using the buttons or by keying in the value. 

Buffer Distance – This is for setting where to start the first cell and end the last cell. Example, placing 
RPM’s on a 10/30 skip line, assuming you snapped to the beginning of the first painted stripe you would 
set the Begin Buffer Distance to 25.0. This accounts for the 10’ stripe and 15’ to get to between the first 
and second stripe, the figure below shows this. 

 

Spacing – There are several options available to set the spacing between the cells, they are: 

1. Increment – This is a set value between cells. 
2. Even – Evenly spaces the cells at a user specified spacing, the buffer distances are ignored. 
3. Max Spacing – The location of the beginning and ending cell are determined, than a 

sufficient number of cells are placed in between, so that the distance between them is no more 
than the specified Max Spacing. 

4. Once – Only one set or cell is placed. The ending buffer distance is ghosted. 
5. Each Vertex – The origin of the cell is placed at each vertex of the selected element. The 

Begin and End and buffer distances are ghosted. 
6. End Points – The origin of the cell is placed at each end point of the selected element. The 

Begin and End and buffer distances are ghosted. 

Hint When placing RPM’s along a curved roadway this tool does not account for the curve 
geometry at an offset. The user will have to copy parallel one of the edge lines on top of 
the 10/30 skip line and use that line as the DGN element then delete the copied line. 
Using the Chain option does not work either; it must be an arc on top of the skip line. 
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Angle – If set to Absolute the angle is based on 0 degrees as horizontal. If set to Relative the cell is 
placed relative to the element selected. 

Justification ‐ The justification can be based on the center cell (only option if only one row is placed), the 
upstream or downstream cell.  Only those toggled on in the Feature Group are available for setting 
Justification. 

LAB EXERCISE: PLACING RPM’S USING DRAW CELL GROUP BY FEATURE (PART 1) 
In this exercise the user will place RPM’s along the 10/30 skip line drawn in a previous exercise. 
Remember that a construction line must be draw on top of the curved section of the skip line in order to 
get evenly spaced RPM’s. 

1. Continuing in Dsgnsp01.dgn open the Draw Cell Group by Feature tool. This tool can be 
opened from the Road tools palette or from the menu Applications > GEOPAK ROAD > 
Plans Preparation > Draw Cell Group by Feature. 

 
2. On the Feature Group tab click on the magnifying glass icon to open D&C Manager. Next 

we will pick one of the RPM items. 
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3. In D&C Manager navigate to Pavement Markings > Pavement Markers > Reflective Pav’t 
Marker and select the Item 0706 3 Reflective Pavement Marker (W/R). 

 
4. Click the OK button or double click on the item in D&C Manager. This will close D&C 

Manager and push this item over to the Feature Group tab. 
You should also notice that the picture of the RPM is now visible in the dialog box. 
The items displayed in this tool are remembered in a .rsc file in the geopak\bin 
directory. If the .rsc files are deleted this tool will be clean with no items filled in. 

5. Set the Offset to 0.0. This is because the first skip line you are placing RPM’s on is in a curve 
and the element you are using in the dgn file is a copy of the edge line on top of the 10/30 
skip.  

 
6. Click on the Location Tab. 
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LAB EXERCISE: PLACING RPM’S USING DRAW CELL GROUP BY FEATURE (PART 2) 
In this part of the exercise you will copy the 6” white edge line over 12’ and complete the Location tab 
of the Draw Cell Group by Feature tool. 

1. Continuing in Dsgnsp01.dgn open the reference palette and turn the dsgnrd01 file off. This 
will make selecting the edge line easier. 

2. Zoom to near Sta. 525+00. You will be working on the right roadway first. 
3. Using the MicroStation Move/Copy Parallel tool copy the 6” white edge line 12’ left.  

 

You should now have a solid line on top of the 10/30 skip line. 

4. Continuing on the Location tab of the Draw Cell Group by Feature tool set the Element to 
DGN. 

5. Click the Identify DGN element button. Next you will pick the line you copied earlier. 
6. Select the line you copied on top of the skip line. Make sure you do not pick the short skip 

line. 
The Begin field will be set to 0.00 and the End will be the value of the total length of 
the element selected, 6807.047 in this example. 

7. Delete the copied line. Once the line is selected it is no longer needed. 
8. Set the Begin Buffer Distance to 25.0.  
9. Set the End Buffer Distance to 0.00. 
10. Set to Increment and enter 40.0. This is the spacing between the RPM’s. 
11. Angle should be 0.00 and Relative. 
12. Set the Justification to Center Cell and Origin. 

 
13. Click Draw and move the pointer over the skip lines and issue a data point. You should now 

see RPM’s centered between the skips. 
14. Take a moment to review the pavement markings. 
15. Do not close the Draw Cell Group by Feature dialog; it is needed for the next exercise. 
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DIRECTIONAL ARROWS 
Using the Draw Cell Group by Feature to draw directional arrows is very similar to how the RPM’s were 
drawn. The Feature Group tab is the same just pick the correct item in D&C for the pavement arrow. In 
the Location tab there are some settings that need to be set based on the standard indexes and the size 
of the arrow cell being placed in order to get the required spacing. 

 

LAB EXERCISE: PLACING TURN ARROWS USING DRAW CELL GROUP BY FEATURE 
In this exercise the user will use the Draw Cell Group by Feature tool to draw turn arrows in the left turn 
lane worked on earlier in this chapter. When placing turn arrows and pavement messages refer to index 
17346 for placement and spacing details. This exercise uses the 6” white lane line as the reference 
element to place the turn arrows.  

1. Continuing in Dsgnsp01.dgn zoom to near Sta. 558+00.  
2. Switch to the Feature tab on the Draw Cell Group by Feature tool. 
3. Click the Magnifying Glass icon in the center field. This opens D&C Manager. 
4. In D&C Manager navigate to Pavement Markings > Thermoplastic > Directional Arrows, 

Thermo STD > 0711 11170 Left Directional Arrow. 

Note You can use the search function to locate items if you know the pat item number or 
description. 

 
5. Either Double Click on the item in D&C Manager or click the OK button. 

This loads all of the items from that category into the drop down menu on the 
Feature Group tab, next you need to select the correct item. 
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6. Next to the Magnifying Glass click the Drop Down menu and select the Left Directional 
Arrow. This will load the appropriate cell. 

 
7. Set the Offset to 6.0. This is the distance from the reference element used to place the turn 

arrows; you must also take into account the cell origin if it is not in the center of the cell. 

 
8. On the Location tab set Element to DGN. Use the 6” white lane line as the reference 

element. 
9. Click the Identify DGN element button and pick the 6” white lane line. Make sure and pick 

the line near the entrance of the turn lane, the left side. 

 

Notice the End distance value is 310’, based on the details on Index 17346 any turn lane longer than 
200’ the designer is to add one arrow for each additional 100’. This means the turn lane in this exercise 
requires four arrows total. 
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In this exercise the white edge line starts at the right that is the Begin and the end is to the left. This is 
important to know before filling in the Buffer Distances. If you use Chain as the element then the Begin 
would be on the left and End would be to the right. 

10. Set the End Buffer Distance to 30.7.  This is the distance from the end of the white edge line 
or stop bar to the origin of the turn arrow cell to get the required 25’ distance from the end of 
the lane line or stop bar to the point of the arrow. 

 
11. Set the Begin Buffer Distance to 15.00. 

 
12. Set the Spacing to Max Spacing. 
13. Set the Spacing distance to 100.0. 
14. Set the Angle to 0.0. 
15. Set rotation to Relative.  
16. Set Justification to Center Cell and Origin. 
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17. Click Draw and move the pointer into the turn lane and issue a data point. 
18. Close the Draw Cell Group by Feature tool. 

The figure below shows the completed turn lane. 

 

LAB EXERCISE: PLACING STOP BAR USING D&C MANAGER 
In this exercise you will use D&C Manager to place a stop bar. The Stop Bar item in D&C Manager has 
the Construct Perpendicular command built into it. When using items from D&C, always read the status 
line in MicroStation for hints. 

1. Continuing in Dsgnsp01.dgn zoom to near Sta. 561+00. This is the end of the turn lane you 
just placed the turn arrows in. 

2. Open D&C Manager. 
3. Navigate to the category Pavement Markings > Thermoplastic > LF Striping, Thermo 

STD > Solid Traf. Stripe (White). 
4. Double click on item 0711 11125 24” Solid Traffic Stripe (White). Read the message field 

in MicroStation. 

 
5. Snap to the end of the Yellow edge line for the start point. 
6. Snap to the white lane line for the end point.  
7. Turn Off Place Influence. The figure below shows the stop bar placed. 
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Quantities 
In this section we will cover: 

• AdHocs  
• Quantities. 

DEFINING ADHOCS FOR QUANTITIES 
AdHocs are additional information that can be used to better define an element or associate a quantity 
to an element. Several of the items in the FDOT ddb file have AdHocs associated to them. It is very 
important to become familiar with the items in the ddb that have AdHocs, understand how they operate  
and how they affect quantities. GEOPAK provides tools that allow the user to select elements and view 
what attributes and AdHocs are associated to those elements. The user can also review an item in D&C 
Manager to determine if there is an AdHoc associated to it. Review chapter 4 of this training manual for 
more information on AdHocs. 

ADHOC ATTRIBUTE MANAGER 
This tool can be used to view AdHocs or Set AdHocs. It can be opened from the Road tools palette   
or from Applications>GEOPAK ROAD>GEOPAK 3PC AdHoc Attribute Manager. 

 

IDENTIFY ELEMENT 
Using this tool is as simple as clicking on the    icon and picking a MicroStation element. If it was 
drawn with AdHocs associated to the element they all display as shown above. If there are no AdHocs 
then the display will be blank. The figure above is showing the AdHocs of a Left Turn Arrow. The 
information displayed is purely for quantities. 

SET ATTRIBUTES 
This is used to set AdHocs on an item, for example: The Nose Paint quantity on traffic separators or 
median openings. There is currently a limit of 48 attributes that can be associated to an element. If the 
user wants to create their own AdHoc for a scenario as shown above, it is a multiple step process. 
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You need to create three new rows for the AdHoc, it needs: 

 Unit 

 Description/String 

 Value 

1. Starting with a blank dialog, click the  Add New Row icon on the right side of the dialog. 

 
2. The Name, in this example, would be the pay item number in D&C Manager, example 

071011290. 
3. The Type would be Unit. 
4. The Value would be SF. The value SF must be all caps. 
5. Repeat the process two more times using the same Name but create two new Types and 

Values as shown below. 

 
6. The Quantity Value is the area the user measured in MicroStation. 
7. Then click the Set Attributes icon and pick the element to add the AdHoc to. The element set 

in this example would be a line drawn in MicroStation in the area of the nose paint. The 
length of the line is not important. 
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8. Next you need to make sure that the item in D&C Manager is set to compute by AdHoc. Use 
the Modify Item option to check the Compute Parameters. The user can right click on the 
Item in D&C to Modify the item. 

 

Notice in the Figure below that the Computation Method is NOT set to Adhoc Attribute. The item must 
be set to use Adhoc Attribute as the computation method, if D&C Manager is to use the Adhoc quantity 
attached to an element for computation. 
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D&C MANAGER – MODIFY ITEM 
In this section the user will learn how to Modify an Item to add an AdHoc. By doing this the AdHoc is 
added as the item is drawn. The process is similar to how the AdHoc was created in the last example. 

In D&C Manager you right click on the item you want to add the AdHoc to, example: Item 071011290 is 
yellow reflective nose paint. Notice in the figure below that the AdHoc Attributes option is toggled off. 
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LAB EXERCISE: ADD AN ADHOC TO D&C MANAGER ITEM 
> MODIFY ITEM 071011290 ADD AN ADHOC 

1. Open Dsgnsp01.dgn in the Signing folder. 
2. Start D&C Manager. Make sure the correct ddb file is loaded. 

Note It is recommended that the FDOT delivered ddb file be copied into the project Symb 
folder and renamed to the eleven digit fin number. This allows the user to modify the ddb 
file without fear of overwriting it when updates are released. 

3. Use the Edit > Find option in D&C Manager to search for item 071011290. This is for 
Reflective Island Nose Paint (White). 
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4. Right click on Item 071011290 and select Modify Item from the menu. This opens Item 
Modify. 
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5. This opens Item Modify, make sure that the Attribute option is toggled ON. This located in 
the top right side of the dialog. 

 
6. On Item Modify toggle on AdHoc Attributes. By default this will be off if there are no 

AdHocs assigned to the item. 
7. Click the AdHoc Attributes button. This opens AdHoc Attributes. 

 
8. Click the Add New Row icon. This is the same process as used earlier; you need a name a 

type and a default value. 
9. For the Name click on New1 and Key in 071011290. This is the pay item and must match the 

D&C Item name. 
10. For the Type select Unit. 
11. For the Default Value, key in SF. Must be upper case. 
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12. Toggle the Lock to Yes. Toggling this on locks the item so when an element is drawn the user 
cannot change it. 

 

> ADD NEW ROW FOR DESCRIPTION AND QUANTITY 

1. Click Add New Row again. It is necessary to create three rows for the AdHoc. 
2. For the Name click on New1 and Key in 071011290. You can copy and paste from the first 

entry. 
3. For Type select String. This is a description of the item. 
4. For the Default Value, key in Nose Paint Yellow. This will show up on the quantity reports. 
5. Toggle the Lock to Yes. 
6. Click Add New Row again. 
7. For the Name click on New1 and Key in 071011290. 
8. For Type select Quantity. 
9. For the Default Value leave it at 0.0. The user will edit this as the elements are drawn.  
10. Toggle the Lock to No. You will fill this in with the area calculated. 

 
11. Click OK. This takes you back to the Item Modify dialog. 

> SET COMPUTE PARAMETERS 

1. On Item Modify click Compute Parameters. This opens Parameters for Target Item. 
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2. Under Computation Method select AdHoc Attribute. If this is already set than ignore this 
step. 

 
3. Click OK to close and save changes in the Parameters for Target Item dialog. 
4. Click OK on the Item Modify dialog. 
5. In D&C Manager select File > Save. This will save this change to the DDB file. 

> PLACE A LINE WITH AN ADHOC 

1. Continuing in Dsgnsp01.dgn zoom to near Sta 562+50. The figure below shows where you 
will be working. 

 
2. If item 071011290 is not selected, select it. This is the item just modified. 

3. In D&C Manager select Design mode  .  
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4. In Design mode toggle on Place Influence and AdHoc Attributes.  

 

Notice when AdHoc is toggled on that AdHoc editor opens. Also notice that two of the rows values are 
red, this is because when you created the AdHoc earlier the two options were locked. 

 
5. Next to Quantity click on the value 0.0 field and enter 25.0. This would be the area measured 

in MicroStation. This is an arbitrary number for this exercise. 

 
6. Select MicroStation’s Place Line tool. 
7. Draw a line from one end of the radius of the median to the other end. 

 
Note The length of the line makes no difference, it could be one inch and the item will quantify. 

The AdHoc is only additional information about an item. 
8. Toggle Off Place Influence. 
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> USE 3PC ADHOC ATTRIBUTE MANAGER TO CHECK ELEMENT 

1. From the Road Tools palette open 3PC AdHoc Attribute Manager  . 

2. In AdHoc Attribute Manager click Identify Element  . 
3. Pick the line drawn in the previous exercise and issue a data point to except it. 

 

The AdHoc information will populate the dialog, this is what will show up when quantities are run. 

4. Close AdHoc Attribute Manager. 

GENERATING QUANTITIES 

REVIEW ITEMS PRIOR TO COMPUTING QUNATITIES 
Prior to computing any quantities it is important to review the items that are about to be computed. 

D&C Managers Display tool will aid in this task. To activate the Display tool, click on the   icon. 

 

 Normal Display – the items of interest change back to their original element symbology. 

 Highlight Selection – the desired elements are displayed in the current MicroStation highlight color, 
while any other elements remain unchanged. 

 Hide Selection – the desired items are not displayed in the view, however all other elements are 
displayed. This is the reverse of the Display Only Selection tool. 

 Display Only Selection – only the items in the collection box appear, while the rest are not displayed 
in the view. 

Using the Highlight Selection the user would zoom in close to the project elements and make sure that 
whatever is placed in the collection bin for computing quantities highlights. 

Note Always set the option back to Normal Display before closing the tool. 
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COMPUTING QUANTITIES 
Plan Quantity Computation opens when the Compute is selected.  

 

The Job is the GEOPAK gpk file, if the user is using Project Manager than this will be set. 

Extents is a list of options for limiting the area and elements included in the quantity calculations. The 
figure below shows the options available.  

 
Active Design File – All elements in the Active Design File are candidates for computation. 
View – Only the selected items that are displayed in MicroStation view one are computed.  If 

the view includes area outside of the Range, the Range will override. 
Fence – A MicroStation fence must be placed, and all specified graphical features which 

satisfy both the fence and the Range will be tabulated.  
Boundary Element – A previously drawn closed shape is used to determine quantities. 

 When selected, the user is prompted to select the closed shape.   This mode is sensitive 
to the MicroStation Inside, Overlap and Clip modes. 

Station Range – A Baseline Reference (chain or dgn) must be defined for this option.  The 
range fields default to the extent of the chain.  The user can key in a station or by 
clicking Begin or End Station icons graphically define the station range.  Perpendicular 
projections to the station(s) define the extent of the computations. This option is not 
ideal for sheet quantities. 

Sheet Range – Sheets placed with the Plan Profile Sheet Composition tool can be utilized. 
Select the option which displays the sheet range. This option will work in our scenario. 

Selection Set – A MicroStation selection set of the candidate compute elements must be 
created prior to computing. 

Boundary Selection Set – A MicroStation selection set of the Boundary (not the actual 
candidate compute elements) must be created prior to computing. This option will work 
in our scenario. When this option is used it uses the element ID number in Quantity 
Manager to organize the data for each individual sheet. 

Baseline Reference allows the user to define a Chain or DGN element for offsets and station values for 
reports. In addition the Range, if set, is measured from the selected Chain or DGN element to search for 
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candidate items. Setting the Baseline Reference to None limits the type of output that can be generated 
as no station / offset values can be computed. 

When using Sheet Range or Boundary Elements it is not necessary to toggle on Begin and End Station 
limits. 

Highlight During Computation when toggled on, all MicroStation elements computed are highlighted in 
the selected highlight color. 

Compute Quantities starts the computation process and when completed opens the Computation 
Results dialog box. 

 

It is imperative that you review these results before going any further. If there are any errors or 
omissions now is the time to fix or add them.  

Export Format sets the type of output the user wants to generate from the reported quantities. There 
are several formats to choose from. 

Comp Book – A more detailed report that lists not only quantity summaries, but also 
geometric properties such as plan view coordinates and station/offsets for located 
elements. File is in ASCII format. 

Item report – Quantities Summary listing pay items, descriptions, units and total quantities 
for located elements. File is in ASCII format. 

Item Table – Contains the same information as the Item Report, but formatted in tabular 
form. 

DBMS – Very detailed information including calculated and rounded quantities, geometric 
properties, pay item numbers, descriptions, station / offset values, etc. The format is the 
selected database (i.e., Microsoft Access, Oracle, SQL Server, and dbase is set in the 
Compute Settings tool. This option is required when taking the quantities into Quantity 
Manager. This is the option used in this training guide. 

CSV By Item –Summary listing pay items, descriptions, units and total quantities for located 
elements. Format is CSV (coma separated values). 
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CSV By Element – A more detailed report that lists not only quantity summaries, but also 
geometric properties such as plan view coordinates and station/offsets for located 
elements. Format is CSV (coma separated values). 

Table – User defined table column properties.  A column for designating the appropriate 
symbol  is also included, as well as adhoc attribute data. This option is used to generate 
legends such as for landscape plans.  

Next to the Export Format is a field for entering the file name of the output file, using the hourglass 
allows you to browse to a specific folder. 

When exporting the quantities there are two options to choose from, Create or Append. This will place 
the quantities into a new file or append them to a previously created file. 

Run and Phase are only used for the DBMS export format to Quantity Manager. The Run is a user key in 
and any logical description, like Pavement Marking or Preliminary, can be used. This description will be 
passed to Quantity Manager. There are several default Phases included in the drop down menu, 
however, you are only concerned with DesignEstimate. This is the recommended Phase when exporting 
to Quantity Manager, as this is the only phase that can be passed to Trnsport. 

Export commences the output file process and creates the quantity file. In this training you will be 
exporting to DBMS which will create an MDB file that can then be opened with Quantity Manager. 

LAB EXERCISE: REVIEW THE QUANTITY ITEMS 
> USE THE DISPLAY TOOL TO REVIEW ITEMS 

1. Continuing in Dsgnsp01.dgn zoom in near Sta 560+00. 
2. click the Display tool on D&C Manager. 

 
3. If there are items in the collection bin of D&C Manager, right click in the collection area and 

select Clear Collection. 
4. Click the ID icon in D&C Manager. 
5. Pick the white edge line and accept it. This will take you to the item 0711 11111 6” Solid 

Traffic Stripe (White). 
6. Right click on the item and select Add to Collection. This will place the item in the collection 

bin. 
7. Click the ID icon and pick the 10/30 skip line and accept it. 
8. Right click on the item and select Add to Collection. 
9. Repeat this process to add the rest of the Pavement Marking items used into the collection bin. 
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10. On the Display tool click the Highlight icon. This will highlight all of the items in the 

collection. 
11. Take a moment to review the design file. 
12. Set the display option to Normal. 
13. Close the Display tool. 
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LAB EXERCISE: GENERATE QUANTITIES FOR QUANTITY MANAGER 
> COMPUTE QUANTITIES 

1. Continuing in Dsgnsp01.dgn reference in Clipsp01.dgn from the Signing folder. 
2. Zoom out so you can see the first five clip borders. 
3. On D&C Manager click the Compute icon. This opens Plan Quantity Computation. 

 
4. The Job number is 415. This will be set if you use Project Manager. 
5. Set the Extents to Boundary Selection. 
6. Set to method Clip. 
7. Set the Baseline Reference to Chain. 
8. Pick the Chain BLCONST. 
9. Toggle on Range. 
10. Set the Range value to 300.00. This is how far from the chain the software will look for items 

to compute. 
11. Toggle on Highlight During Computation. 
12. In MicroStation use Power Selector to pick the first five clip borders. 

 
13. Click Compute Quantities. This opens Computation Results. 
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Note there is a known issue with GEOPAK crashing when computing quantities with reference 
files attached. If MicroStation crashes while running quantities, make sure locate is 
turned off on all reference files and copy the clip borders into the active design file. 

> EXPORT QUANTITIES TO DBMS FOR QUANTITY MANAGER 

1. Set the Export Format to DBMS. This is the required format for Quantity Manager. 
2. Using the Magnifying Glass icon browse to the Signing folder. 

 
3. Enter a file name, I recommend using the fin number. The MDB file extension will be added 

automatically. 
4. Click OK. 
5. Set to Create. The options are Create or Append. 
6. For Run enter Pavement Markings. 
7. For Phase select DesignEstimate. This option must be selected. 

 
8. Click Export. This creates the MDB file. 
9. Close Computation Results. Next open Windows Explorer and make sure the file was 

created. 
10. From SiteMenu select Standards > Explore Current Working Directory. 
11. You should see the MDB file in the Signing folder. 
12. Close Windows Explorer. 


